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Installation 
 

Extract the files from the Octane_1022kk.zip file into the ../Sketchup../Plugins/ folder, keeping the sub-
folder structure for several of the files – see below. 

 
You must ‘extract’ the files, keeping any sub-folders – so do not uncompress everything directly or open the 
archive, select and then drag+drop the files [unless you are sure what you are doing] - as doing it that way you 
could end up with files in the wrong relative relationships.  On a PC you should use the ‘extract’ option in your zip 
application; on a Mac a double-click might not keep them in their sub-folders, so you should use right-click 
‘unarchiver’ or ‘stuffit_expander’… 
 

If you are unclear about where your ‘Plugins’ folder might be then type [or copy+paste] this line into the  
Window > Ruby Console: 
 

  Sketchup.find_support_file("Plugins") + <enter> 
 

Typically the PC path that is returned is: 
 

  C:/Program Files/Google/Google SketchUp 7/Plugins 

 
Whilst typically the Mac path that is returned is: 

 
  Macintosh HD/Library/Application Support/Google Sketchup 7/SketchUp/Plugins 
 
So there should be the following: 

 

In the folder ../Plugins/ 
 

  Octane_loader.rb  The file that loads the current script below. 
  win32ole.so   A file used by the PC version of the tool 

[since this does nothing on a Mac and could be discarded, on a Mac]. 

  README.txt   This file can be discarded - it only explains the initial installation. 
 

And in the folder ../Plugins/Octane/ 
 

  Octane_1022.rb  The script that sets up the Octane Render Sketchup Exporter tool. 

  OctaneDialog.html  The file that is used to make the main web-dialog for that tool. 
  OctaneDialogStrap.png The logo image used by the html file. 

  OctaneDialogBack.png  The background image used by the html file. 
  OctaneToolbar16x16.png An image used for the Octane Render toolbar ‘small’ button. 

  OctaneToolbar24x24.png An image used for the Octane Render toolbar ‘large’ button. 
  OctaneHelp.pdf  This Help file. 

 

And in the folder ../Plugins/Octane/OctaneFolderBrowser/ 
 
  folder_browser.html A file used to make the special folder-browser dialog. 
  folder_browser.js  A file used with the special folder-browser dialog. 

  folder_browser.css  A file used with the special folder-browser dialog. 

  folder.png    The image used for the folder-icons in the special folder-browser dialog. 
  folderup.png   The image used for the folder-up-icon in the special folder-browser dialog. 

 
And in the folder ../Plugins/Octane/OctaneSlider/ 
 
  slider.js   A file that is used to make the main dialog’s sliders. 

  slider_Bar.png  The image used for the slider’s ‘bar’. 

  slider_Btn.png  The image used for the slider’s ‘button’. 



Usage 
 

After installation and the restart of Sketchup you should have an additional menu item to run the tool 
 

File > Octane Render… 
 

There is also an Octane Render toolbar – by default it is not active – you can activate it from the matching  

View > Toolbars menu item [or Mac equivalent].  Clicking its button is the same as picking the main menu item. 
 

There is also a ‘right-click’ context-menu - Octane Render… – it also works the same as the main menu item.  
 

Alternatively you can also type octane into the Ruby Console… 
 

The Dialog 
 

 
[showing default settings]. 
 



The first section is “Project Configuration”. 

 
On the first run you will be pressed to choose an Octane Render Binary file – the application that the tool will 

use to process the render.  It will be remembered with Sketchup for any future sessions. 

 
On a PC it should be the octane.exe, on a Mac it should be the octane.app. 

 
Should the specified Octane binary file become unavailable between sessions you will be prompted to select an 

alternative. 

 
After the set up you can change to another Octane application by clicking the Browse button. 
 
The Project Path initially defaults to the current model’s folder – you can change this by clicking the Browse 
button at any time.  
A special folder-browser will open – highlight the desired folder and press OK: the current folder is displayed along 

the top of the dialog, to navigate up double-click the topmost folder-up icon [../], to navigate down into a folder 

double-click its icon. 
If you save the model when you close it, then this path is remembered with the model. 

 
The Project Name initially defaults to the model’s name, with any spaces replaced with an underscore: 

my_model.skp gives my_model for the Octane my_model.ocs file], you can type in another name if required; if the 

.ocs file doesn’t exist then it will be made if you run the rendering parts of the tool.  Alternatively, you can click on 
Use Existing Project button to find an existing .ocs file… then both the Project Path and the Project Name will 

be changed to suit that selection.  Note that a previously made .ocs will be ‘relinked’ and will not update existing 
materials’ textures etc – so with major changes it is best to start a new .ocs or rename the old one. 

 
The dialog also shows the model’s units settings – Native Unit Size – this is non-editable and is for information 

only [and to keep consistency with other exporters’ UIs] - all dimensions used within the tool are automatically set 

to the units required by Octane – i.e. ‘meters’. 
 

To the right of this is a Help button that opens this file [OctaneHelp.pdf] - if it is found in the ../Plugins/Octane/ 
folder. 

 

 
The second section - “Export Configuration” - lets you choose what settings to use with the export [if any]. 

 
Film 

Resolution    Initially disabled, if enabled you can change the following 

Width    The image width, defaults to the screen width 
Height   The image height, defaults to the screen height 

  Percentage  The standards are 100%, 75%, 50% and 25% which are applied to  
     the current width and height settings 

     The other drop-down’s option is Reset with reverts  
     to the model’s screen width and height 

Camera 

  Export Camera Initially enabled, you can change the following settings 
         Active Camera This defaults to from <Current View> 
     Other options in the drop-down are from <Current Scene> and  
     then any available ’Camera’ from the ‘Scenes’, listed in their order. 
     Note that if this option is enabled and Render Animation is  

     invoked then this selected Camera is ignored and each animation  
     frame’s Scene’s Camera is used  instead 

Lens Aperture Radius Initially disabled, default=1, you can type in any value between 0  
and 1 – e.g. 0.25, or use the slider to change the value.  When typing a 

value the slider will update to the new value when you press enter or the 
text input box loses focus 



Focal Depth (m) Initially disabled, default=5, you can type in any value > 0, or use 

the slider for values up to 100, if a value > 100 is desired then type in 
that value – the slider will stop at the maximum extent (100).  When 

typing a value the slider will update to the new value when you press 

enter or the text input box loses focus 
Motion Blur   Initially disabled, default=Next, choose Next/Previous – to blur  
    between scenes in animations 

     If the Active Camera=from <Current View> then Motion Blur is  

     inoperable in the Render Frame mode as it has no ‘next/previous  

     scene 
     If there is no ‘next’ scene then the first scene is used, if there is no  
     ‘previous’ scene then the last scene is used 

Note that if this option is enabled and Render Animation is  

invoked then the camera for the Scene next or previous to the animation 
frame’s Scene will be used in each frame, if it is available 

Daylight Environment 

         Export Sun Direction Initially disabled, you can choose the following setting 
   Light Source This defaults to Sun from <Current View> 
     Other options in the drop-down are Sun from <Current Scene> and  
     then any available ‘Sun’ from the ‘Scenes’, listed in their order. 

Note that if this option is enabled and Render Animation is  

invoked then in  each animation frame that Scene’s Sun will be used 
instead 

GPU Devices 
  Specify GPU Devices Initially disabled, you can choose the following settings 

Default is 0 – choose from 0, 1, 2, 3 as the GPU[s] to use: 
NOTE: it currently can cause Octane to hang on startup if enabled AND 
any number is checked 0-3 at all.*** 
Temporary Solution: try it, and if it hangs next time don’t try to specify 
the GPU using these settings… 
 

 

The third section - “Export” - lets you choose the type of render - either 
 
Frame 

Export OBJ/MTL Only Click this button to export the current model as OBJ/MTL to the  
path defined earlier [and if appropriate, any Textures are put into a sub-

folder with the same name + _Textures, which is made if it doesn’t exist].  

The OBJ file is set to Octane’s required units ‘meters’, has triangulated 
faces etc…  All Geometry, Groups, Components and Images [that are not 
‘hidden’ or on non-visible layers] are exported, as separate triangulated 
faces, with their materials or textures.  Note that UV-mappng of textures 

[position/scae/rotate/etc] within the SKP is supported, but if you have 
‘skewed’ a texture that cannot be transferred into the OBJ/MTL format – 

so in that rare case, before running this tool, in the SKP right-click the 

affected face and select ‘Make Unique Material’ – a new ‘cloned’ textured-
material will be made with the image having a built-in distortion to suit 

[unfortunately this is not (yet) available as an automated method through 
the current SUp API, but perhaps it could be added to this tool after an 

appropriate update]. 

 
Render Frame  Click this button to export the OBJ/MTL as above, and then  

automatically open Octane.  A new OCS is made if it doesn’t exist. 
A minimized cmd window called Render Cmd opens to activate the OCS; it 
remains open whilst the OCS itself is open – on a PC this cmd window can 
be closed at any time, and it will close with the OCS anyway. 

Octane starts to render the OCS using the various export settings you 

have selected – the s/px is automatically set to the standard maximum 
[16000] which you are unlikely to want to exceed;  note that you can 
pause or stop the rendering at any stage and/or change other settings in 
the OCS manually. 

 
or 
 



Animation 

 Image Output   This defaults to the Project Path set above, with img00001.png – you 
can enter an alternative, or click the Browse button and a special folder- 
browser will open – highlight the desired folder and press OK: the current 

folder is displayed along the top of the dialog, to navigate up double-click 
the topmost folder-up icon [../], to navigate down into a folder double-

click its icon.  Again it will default to img00001.png which you can adjust 
as desired.  You can type in any image name here, after the folder 

separator (\ or /), but remember that it must have a ‘numerical’ ending so 

it can be incremented (like anim9009.png) and it must also have a .png 
suffix.  The output images in the animation sequence will all be saved into 
the Image Output folder; their names will increment based on the image-
name format – e.g. img00001.png, img00002.png, img00003.png etc 

 
Start/End Frames These are listed in pull-downs from all of the available Scenes [Cameras], 

but only those Scenes marked in the Sketchup ‘Scene Manager’ to be 

‘included in animation’ – i.e. without enclosing (…) in their tab label… 
 

Start Frame Defaults to the first Scene, it can be any of the available Scenes except 
the last one. 

 

 End Frame   Defaults to the Scene after the Start Frame’s Scene [typically the second  
     Scene], it can be any Scene later than the Start Frame’s Scene. 

 
 

Step    Defaults to ‘1’, the available Steps are listed in a pull-down determined  
    from the Start/End Frames selected. 
 

Pixel Samples Defaults to Medium (256 s/px), choose from various setting, or type in a 
Custom value in the box to the right – it must be at >= 1; but 8 is small – 

use these low settings for quick testing of animation frame-sets ! 
 

Render Animation  Click this button to start the rendering of the frame-set specified. 

Note that the selected Scenes’ Cameras, Motion-Blur and Light-Source are  
 used if the respective Export Configuration options are ‘checked’ - their  

 Frame Render specific Scene/Light-Source settings are ignored for this  
 animation. 

Other ‘checked’ configurations will also be used, e.g. ‘Focal Depth’. 
This button’s title changes to say ‘Rendering Animation, Please Wait…’’,  
and it is then disabled during the rendering loop.   
A minimized cmd window called Animation Cmd opens in the 
Taskbar/Dock area and opens that the OCS – once for each frame in the 

animation – it remains open whilst Octane is processing the animation 
sequence.  To abort the rendering iteration part way through you can 

close this ‘cmd’ window early [the Command-line prompt also tells you 

this]: The oCS will complete the current frame’s render and stop without 
processing further frames in the set.  On completion of the set of the 

animation’s frames’ images [or its early cancellation], the dialog’s button 
becomes re-enabled and its title reverts to ‘Render Animation’  and it can 
be used again... 

 
 

 
 
***See ‘Known Issues’ below… 
 

 



Version: 
 
1022. 
a 20100611 First beta release. 

b 20100613 Second beta release. Camera location swap y/z fixed.  

             Sun location swap y/z fixed. 
             Animations start-frame/end-frame/step from pull-down lists of  

             available Scenes [i.e. without those 'excluded from animation'  
             in the Scene Manager]. 

c 20100614 Help button added to open OctaneHelp.pdf in Octane folder. 

             Animation Start/End/Step pull-downs linked and animation cmd  
             methods fixed.  'Step' not implement yet [always = 1]. 

             All settings now remembered with Model. 
d 20100614 Step now implemented in animation. 

e 20100615 UI messages improved. Animation typo error corrected. 
f 20100615 Naming of exported texture files now always mimics SUp's tw output. 
g 20100616 Mac feedback addressed, somewhat. 

h 20100616 Mac execution of command addressed with initial #!/bin/sh ? 
i 20100618 Mac commands corrected.  Other minor UI changes for all. 

j 20100618 Mac command line escaping \"...\" finally sorted – partially. 
k 20100621 Mac command execution fixed.  Mac multi-app _anim \" fixed to ";  

                 _anim has own obj/mtl BUT now uses SAME ocs file. 

l 20100629  Mac command execution still buggy - further fixes tried [bash]. 
       Link/Re-link of anim files resolved. 

m 20100701 Mac executable path fixed. 
n  20100702 file:/// used for Mac executable. 

o  20100702 Further tweaks to Mac version for auto-execution of .commands. 

p  20100706 Adjustments to Help file path for Mac. Install README added to zip. 
                  Menu name changed to 'Octane Render'. New ocs creation merged into  

                  first render.  New 'folder_browser' added.  Image_output path now  
                  correctly remembered with model. 

q 20100709 General tidy up.  MTL/Texture image-names now 'tied' to avoid SUp  
                  'locale' glitches, where Material Image's name can differ  

                  completely from the texturewriter's given name! 

r 20100709 Folder Browser fail on non-existent folder fixed and other tidying. 
                 Error with MTL/image naming in some locales addressed. 

                 YUI slider js details revised. 
s 20100710 All MTL's 'Ks' values zeroed. 

t 20100713 Slider js is now fully integrated into dialog. 

u 20100715 JS errors with some browsers circumvented. 
                 Dialog deactivates on Cancel [X]. 

                 Camera.up vector normalization glitch fixed. 
v 20100716 JS errors with some browsers/OS circumvented - 'populate' moved  

                  from 'body' in .html into <body> header with onLoad=””. 
w 20100716 The <body onLoad=""> solution that works for PCs is abandoned.   
                  The .html's 'populate' script code moved from the <head> area  

                  to just after the </body> tag, for cross-platform compatibility. 
x 20100716 Newly made OCS will now 'link' [-l], without a 'relink' [-r]. 

                  Maximum-sample value [-s 4096] removed for single-frame render option. 
                  The .html's 'populate' script code now moved to just before the </body>  

                  tag for cross-platform compatibility. 

                  Folder-browser code revisited for cross-platform compatibility. 
y 20100719 Folder-browser 'populate' code updated for Mac compatibility. 

                 Ongoing problems with 'populate' running at right time across PC  
                 & Mac platforms resolved.  Sun-vector normalization addressed. 

                 Glitch with lens/focal values from sliders 'to_strings' corrected. 

                 The 'Default_Material' now uses the current RGB values for MTL file. 
                 New tooltips, 'Context-menu' item and 'Toolbar' added. 

                 Dialog background 'rays' added. 
z 20100719 In an attempt to get all WIN [PC] and Mac versions compatible  

                  the .html etc has been split into versions for each OS. 
 

 



aa 20100721 Further revisions to the html MAC version to get the dialog to  

                   do its 'populate' at the correct time. CSS for MAC fonts improved. 
                   Dialog fonts etc adjusted to be more cross-platform friendly. 

                   In addition to Groups & Component-Instances 'Images' are now exported. 

bb 20100722 The 'cmd' windows now start minimized in the Taskbar/Dock, and  
                   are titled 'Render Cmd' or 'Animation Cmd'. 

                   More MAC adjustments to resolve ‘populate’ problems. 
                   This is an intermediate step with 'annoying messages' for MAC  

                   users to assess how the dialog is loading... 

cc 20100724 MAC messages removed and more adjustments to MAC 'populate' code  
                   to try and resolve MAC dialog problems. 
dd 20100725 PC and MAC 'populate' ruby and html code now fully ‘booleaned’ to avoid MAC glitches. 
ee 20100726 Coding and HTML further adjusted for MAC compatibility. 

ff 20100727 More coding and HTML adjustments for MAC compatibility. 
gg 20100728 Populate method again revised to attempt MAC compatibility. 

hh 20100728 Checkboxes streamlined, plus 'gpu' combos [Octane can still freeze!]. 

ii 20100728 Some ‘populate’ methods reverted/duplicated to attempt MAC compatibility. 
jj 20100729 More radical changes to checkbox code to attempt MAC compatibility. 

kk 20100729 Even more radical changes to checkbox code to attempt MAC compatibility. 
 

 

Known Issues:*** 
 

Selecting more GPUs that you have on your system can cause Octane to hang on startup. 

Avoid using this option if it causes you problems...  RS to advise further… 
 

The 'octane.cmd' and 'octane_anim.cmd' files [suffixed '.command' on Mac] are not currently auto-deleted from 
the Project's Folder after execution - this is for debugging purposes, so that these files can be opened to 
view/change the contents/actions and retest externally.  Do not double-click them unless you want them to run! 
 

The non-transfer of any new materials’ transparency on a re-linked render/_anim etc needs to be advised on 

further by RS.  It seems preset in Octane and unrelated to the exporter’s files themselves [obj/mtl] which do 
contain the new materials with all of their values correctly set.  Clearly you don’t want to overwrite any values of 

materials that were previously loaded, and which you might have subsequently changed in Octane itself: but on a 
re-link surely any newly added materials Octane finds should be used with their initial setting taken from the mtl-

file– and not ‘defaulted’ as seems to occur now?? 

 
Currently using the GPU settings can sometimes cause Octane to ‘freeze’ on startup if enabled AND any number is 

checked 0-3 at all, or you specify more GPUs than you have.  Temporary Solution: try it, and if it hangs next time 
don’t try to specify the GPU using these settings – perhaps some CUDA settings ?  RS to comment… 

 

This tool is now working OK for the PC and the Mac – but some issues with the Mac dialog are still being 
addressed. 

 
If you have an early version OS on your PC – e.g. XP - please upgrade your Internet-Explorer to at least v7 – v8 

recommended - earlier versions of IE can create java-script issues when run with Sketchup’s API based web-
dialogs… 

 
Feedback welcome… 

 
 
 
TIG 


